AP Computer Science A @Beijing National Day School

Intalling the BlueJ IDE for Java Development

Due date: September 2019
Instructor: Mr. Alwin Tareen

Part A: Downloading and Installing the BlueJ Integrated Development
Environment(IDE)

The following is a step-by-step tutorial for downloading and installing the BlueJ software that we will
use in this class for developing Java programs. This tutorial goes through the process with Windows,
but Mac users should be able to use this tutorial as well.

1. Point your browser to the following URL: www.bluej.org and you should see the following:
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"One of my favourite IDEs out there is BlueJ"
— James Gosling, creator of Java.
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2. Scroll down a bit, and you should see the following links. Windows users should download the
link BlueJ Combined Installer(includes JDK), and Mac OS X users should download
the link that is appropriate for their specific operating system version.

Download and Install
Version 3.1.5, released 29 March 2015 (what's new)

Windows

BlueJ Combined Installer OR 1. Oracle JDK
(includes JDK)

2. Blued Installer

Mac OS X
’ 10.7[Lion].3 and newer: OR 10.7[Lion].2 and older:
BlueJ Installer BlueJ Installer
(includes Oracle JDK) (uses Apple JDK)

3. Once you have finished downloading the file, double click on it. You should see the following
dialog window. Click on Next.

Welcome to the Bluel Setup Wizard

The Setup Wizard will install Blue] on your computer. Click
Mext to continue or Cancel to exit the Setup Wizard.




4. You should see this window, asking if you want to install just for you, or everyone. Selecting
Install just for youis fine. Click on Next.

T Blue) Setup ()

Installation Scope

Choose the installation scope and folder

@ Install just for you [Administrator]
Blue] will be installed in a per-user folder and be available just for your user
account. You do not need local Administrator privieges.

Install for all users of this machine

Blue] will be installed in a per-machine folder by default and be available for all
users, You can change the default installation folder. You must have local
Administrator privileges.

5. Next, you will be asked about file associations and shortcuts. These checkboxes are selected by
default, which is fine. Click on Next.

Select Associations and Shortcuts
Select which optional extra items you would like installed

| Add File Assodations (*.bluej, *.bjar)

| Create Program Menu Shortcuts

| Create Desktop Shortcut




6. Then, you will be asked about a destination folder for the BlueJ program. The default location is
fine. Click on Next.

Destination Folder
Click Mext to install to the default folder or dick Change to choose another.

Install Blue] to:

|C: \Program Files'\BEluell,

Change...

7. You will be presented with a Ready to install Bluel window. All the settings are fine, so
click on Install.

Ready to install Bluel

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Clidk Cancel to exit the wizard.

Install




8. Finally, you will see a window comfirming that you have completed the BlueJ Setup Wizard.
Click on Finish.

Completed the Bluel Setup Wizard

) :"" Click the Finish button to exit the Setup Wizard.




Part B: Writing, Compiling and Running a Java Program in Blue]J

1. You should see a BlueJ program icon on your desktop. Double-click this icon to run the program.
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3. The BlueJ Integrated Development Environment program will appear. This is the main user
interface in which you will develop your Java programs.

Project Edit Tools View Help
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Use the Project menu to create or cpen a project

Bluel 315

4. Click on the Project menu, then select New Project... and the New Project window will
appear. You should choose a suitable place to put your Java programs. I have created a folder
called apCompSci, and then a subfolder called blueJCoding, in which I will place my Bluel
projects. If you wish to create a similar folder scheme, select Cancel, then create the necessary
folders using Windows explorer, then come back to this New Project window. Select the folder
location where you want to place your project. I have chosen the location blueJCoding. Finally,
type the name of your project into the Folder name: dialog box. Pay attention to what’s
happening here. I'm typing in the name of a folder, not a file, so there won’t be any file
extensions, such as . txt or . java, and the name of this particular folder is:
summerAssignments

Project Edit Tools View Help

I
Hew <& Mew Project

Lock in: apCampSei - £f B~

barrensTextbook
bluelCoding
summerhssignmentBluellnstall

<5

Recent Ttems

Desktop

My Documents

“,
‘.‘4 Folder name: pCompSei \bluelCoding! sunmerAssi gnment o

Tetwork  Filoo of uper a1 Filec . == '




5. After creating a project folder, your BlueJ environment should like like the following screenshot.
Now, we are going to create a Java program. Click on the button New Class...

Project Edit Tools View Help

MNew Class...
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Initialising virtual machine... Done.

6. The Blue]: Create New Class window should appear.
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7. Type HelloWorld into the Class Name: dialog box, then click on Ok.
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8. The BluelJ environment should look like the following screenshot. Notice that there is a new box
in the canvas with the title HelloWorld. This represents the HelloWorld Java file. Now, we
must type a Java program into that file. Double-click on the HelloWorld box.
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9. A new editor window should appear, which contains the Java program code of the HelloWorld
file. I have resized the windows so they fit in one screenshot, but you should recognize the Bluel
environment on the left, and the editor window with the Hel1oWorld file on the right. Bluel

places a standard Java program into a new file by default, but we generally don’t use this, so we
should erase it.

Class Edit Tools Options

P Cumpne‘ Jn Source Code
% Blue): summerAssignment —

Project Edit Tools View Help
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—— % Write a description of class HelloWorld here
|NEW Class | HelloWorld "
| J—— | ‘ % Bauthor (your name)

[ —> |
| Compile |

# @version (a version number or a date)
wf

public class HelloWorld

i

private int x;

S

# Constructor for objects of class HelloWorld
wf

public HelloWarld()

% An exanple of = method — replace this comment with your omn
*

% Gparam ¥ s sample paramstsr for a methed

# Gratwn  the sum of x and ¥
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public int sanpleMethod(int y)

f

10. Click your cursor in the editor window, then type Ctrl-a to select all of the text in that window.
You should see everything highlighted in yellow, like the following screenshot.

Project Edit Tools View Help
[k

P— % Write 2 description of class HelloWorld here.
‘New Class.. ‘ HelloWorld *
‘ — ‘ ‘ # Bauthor (your name)

e % @version (a version mumber or & date)

‘ Compile ‘

L7
public clazz HelloWorld
{

private int x;

Sk

# Constructor for objects of class HelloWorld
*/

public HelloWorld ()

% An sxanple of a nathod - replacs this comment with your own
*

# Gparan y  a sanple parameter for a method
® Breturn the sun of x and ¥

*/

public int sampleMethod(int y)
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11. Press the backspace key to delete the selected text. You should see a completely empty text
editor window, as in the following screenshot.

Class Edit Tools Options

V22

12. T have listed a simple Java program below, now you must type this into the editor window
exactly as it is stated, with no mistakes, and with all of the strange punctuation characters
included. As we will learn, these are actually control characters in Java. There is also a strange
indentation pattern you must follow, where each indent is 4 spaces.

public class HelloWorld

{
public static void main(String[] args)
{
System.out.println("Hello, world!");
}
}
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Class Edit Tools Options

public class HelloWorld

Project Edit Tools View Help
{

public static void main (String[] args)

[New Class..| HelloWorld :
[ -3 | System. out. println("Hells, world!");
— ‘ 1

‘ Compile ‘

File saved




13. After you have typed in the Java program, and are satisfied that there are no errors, you must
compile the program. Click on the Compile button on the text edtior, or click on the one in the
Bluel environment. They do the same thing. If you have typed your program correctly, you
should see something like the screenshot below. Notice that the diagonal lines on the
HelloWorld box are gone, and you see the phrase Compiling. . .Done at the bottom. If,
however, you made some mistakes in your program, an error message will appear. You must
correct all of the mistakes before the program will compile.

- Source Code -
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Project Edit Tools View Help pritles el El il

{

public static void main(String[] args)
[New Ciass.. | HelloWorld :
[ —> ‘ | System out println(Hello, worldl”™);
—> }
1

‘ Compile

Compiling... Done

File saved

14. Our next step is to run the Java program. Right-click on the HelloWorld box, and you should
see a small dialog box appear. Select the option listed as void main(String[] args), it
should be the second one. Then, a Method Call dialog box should appear, like in the following
screenshot. Click on Ok.

Class Edit Tools Options

public class HelloWorld
{

public static void mainiStringl] args)
‘NQW Class | HelloWorld 0
-—> ‘ Systen. out. println(‘Fallo, world!");
— 1

‘ Compile |

Project Edit Tools View Help
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File saved




15. After clicking on Ok, a Terminal Window should appear. This displays the words Hello,
world! which was exactly what we wanted the program to do. I have resized the Terminal
Window and placed it at the lower left hand section of the following screenshot. If you get to this
step, then congratulations! You have successfully run your first Java program!

Project Edit Tools View Help Class Edit Tools Options

MNew Class... ] HelloWorld
public class HelloWerld

Source Code

-
{
I—I public static void mainiString[] args)
Compile {

1

System. out. printlni"Hello, world!”);

%% Blue): Terminal Wind

Options

Hello, world!

‘ File saved

16. Now that you have finished this tutorial, you can use this write-compile-run cycle to create your
own Java programs.



Selecting the Clear screen at method call Option

e Select the Options menu from the Terminal Window, and select the option Clear screen at
method call.

Blue): Terminal Window - summe... - + X
- Clear Ctri+K
Copy Ctri+C
Save to file... Ctrl+5
Print

Clear screen at method call
Record method calls
v Unlimited buffering

Close Ctri+w

e Make sure that the option Clear screen at method call has a check mark in front of it! If
this option is not checked, then it can lead to some very unusual behaviour on the Terminal
Window display, which is confusing for students.

Blue): Terminal Window - summe... - + X
- Clear Ctri+K
Copy Ctri+C
Save to file... Ctrl+5
Print

v Clear screen at method call
Record method calls
v Unlimited buffering

Close Ctri+w




Web Resources for Learning Java

The following are some excellent web resources to guide you. If you are able to gain some
programming experience early on, it will be extremely beneficial for you. Good luck!

Note: Do not pay for any of these courses! There is always a free “Audit this course” option
offered.

edX: An online learning destination and MOOC provider

http://www.edx.org

Introduction to Programming with Java Part 1: Starting to Code with Java

— Institution: UC3Mx
— Course number: IT.1.1x

— https://prod-edx-mktg-edit.edx.org/course/
introduction-programming-java-part-1-uc3mx-it-1-1x-0

Introduction to Java Programming - Part 1

— Institution: HKUSTx
— Course number: COMP102.1x

— https://www.edx.org/course/
introduction- java-programming-part-1-hkustx-compl02-1x-1

Introduction to Java Programming - Part 2

— Institution: HKUSTx
— Course number: COMP102.2x

— https://www.edx.org/course/
introduction-java-programming-part-2-hkustx-compl102-2x-1

University of Helsinki: Department of Computer Science, MOOC platform

e http://mooc.fi/english.html
e Object oriented programming with Java, part 1

— http://mooc.fi/courses/2013/programming-part-1/
e Object oriented programming with Java, part 2

— http://mooc. fi/courses/2013/programming-part-2/

Stanford Engineering Everywhere(SEE)
e https://see.stanford.edu/
e Programming Methodology

— Course number: CS106A
— https://see.stanford.edu/Course/CS106A


http://www.edx.org
https://prod-edx-mktg-edit.edx.org/course/introduction-programming-java-part-1-uc3mx-it-1-1x-0
https://prod-edx-mktg-edit.edx.org/course/introduction-programming-java-part-1-uc3mx-it-1-1x-0
https://www.edx.org/course/introduction-java-programming-part-1-hkustx-comp102-1x-1
https://www.edx.org/course/introduction-java-programming-part-1-hkustx-comp102-1x-1
https://www.edx.org/course/introduction-java-programming-part-2-hkustx-comp102-2x-1
https://www.edx.org/course/introduction-java-programming-part-2-hkustx-comp102-2x-1
http://mooc.fi/english.html
http://mooc.fi/courses/2013/programming-part-1/
http://mooc.fi/courses/2013/programming-part-2/
https://see.stanford.edu/
https://see.stanford.edu/Course/CS106A

MIT OpenCourseWare
e http://ocw.mit.edu/index.htm
e Introduction to Programming in Java

— Course number: 6.092

— http:
//ocw.mit.edu/courses/electrical-engineering-and-computer-science/
6-092-introduction-to-programming-in-java-january-iap-2010/index.htm


http://ocw.mit.edu/index.htm
http://ocw.mit.edu/courses/electrical-engineering-and-computer-science/6-092-introduction-to-programming-in-java-january-iap-2010/index.htm
http://ocw.mit.edu/courses/electrical-engineering-and-computer-science/6-092-introduction-to-programming-in-java-january-iap-2010/index.htm
http://ocw.mit.edu/courses/electrical-engineering-and-computer-science/6-092-introduction-to-programming-in-java-january-iap-2010/index.htm

